ANNEX 3: DATA COLLECTION PROTOCOL
A3.1 INTRODUCTION

The protocol was written before the first round of data collection. At the time, digital forms

(created with Microsoft Infopath) were used to record metadata. These forms have later been

replaced by Microsoft Access datasets (see Annex 4). The instructions offered below are based

on the system that uses the Infopath forms. The protocol was written in a way that other people

could use it in case their help was needed in the data collection process.

A3.2 DATA COLLECTION FORM GUIDE
BEFORE YOU START

Before you can start using the form there are a few things you will need:

1. The google chrome browser:
http://www.google.com/chrome/index.html?hl=nl&brand=CHMB&utm_campaign=nl&utm
_source=nl-ha-emea-nl-bk&utm_medium=ha

2. Two google chrome extensions for exporting web pages to pdf:

a. Web2PDFConverter;

b.

Save as PDF.

To download and install these extensions take the following steps:

whNh ke

Open the google chrome browser;

Type chrome://extensions/ in the url address bar and go to the address;

Click the link ‘Meer extensions ophalen >>’ or ‘Get More Extensions >>’in the
lower-right of the screen;

Search for both extensions one by one (they will be the first search results you
find) and click on the corresponding search result;

Click the button ‘Installeren’ or ‘Install’ and wait for the extensions to be installed;
If you followed these steps, icons for the extensions will be added to the taskbar
of your google chrome browser. You can export any webpage you are watching
by clicking one of the icons and saving the PDF-file that is produced. In some
cases one of them does not work. Having two extensions makes sure that there
is always a backup extension in such a situation.



GETTING STARTED
All files that are directly related to the first round of data collection can be found at the following

network address:

T:\Governance_of_energy_and_material_flows\Ph.D. Wouter Spekkink\First round of data

collection

| will refer to this as ‘the main folder’. Within the main folder two of the most important folders
are the ‘Cases’ folder and the ‘Form (original)’ folder. Under no circumstances are you allowed
to move or make any changes to ‘Form (original)’ folder or its contents. The file contained within
this folder (Data collection form first round.xsn) is the template for all forms that are filled out
and stored. All forms have to remain linked to the template file and making any changes to the

template file’s location or contents will affect these links.

To start searching for data for a new case you first have to create the necessary subfolders in

the ‘Cases’ folder:

1. Open the ‘Cases’ Folder;

2. In the taskbar, click File>New=>Folder;

3. A new folder will be added. Rename the folder such that it has the same name as your
case.

4. Open the new case folder you just added;

5. Create three new folders (see point 2) and name them: Documents, Webpages, and
LexisNexis. These folders will be used to store all files that you find through the data
collection;

6. Now go back to the main folder and open the ‘Form (original)’ folder;



7. Open the template file (Data collection form first round.xsn);

8. Before filling out any details save this file to the right location (the new case folder you
created at point 2). Use the name of the case as the filename (in the taskbar, click
File->Save As->Go to the folder of the new case and save the file using the case name

as the file name).

If you followed the steps outlined above you will now have a new case folder (including its three

subfolders and the new form). You can now start using the form itself.

USING THE FORM

With the new form open, you can start collecting data for the case that is assigned to you. First,
fill out the fields of the ‘General information’ component as much as you can (see Appendix | for
a reference guide to all the fields of the form). It is also advisable to check other forms that are

already filled out for examples of how to use the forms.

To start the search open the google chrome browser and go to a search engine (this will
typically be the google search engine). Use the search engine to perform you first searches and
make sure that you record the used search engine, keywords, and the motivation for the use of
these keywords in the corresponding fields (see Appendix I). Use the following protocol for all

searches:

1. Enter a keyword and perform search (and record all related information in the fields of
the ‘General information’ component). It is advisable to start the search using the name
of the case. After this first search it will be quite easy to come up with new relevant
keywords, based on the information that you found after the first attempt; also, see other,

filled out forms, for examples of useful keywords;



2. Click all search results, unless you are absolutely certain that the search result is not
related to the case;

3. If you found a relevant webpage, export it to PDF (by clicking one of the google chrome
extensions you downloaded earlier; see beginning of instructions) and save the PDF file
to the ‘Webpages’ folder of the case folder (use the webpage number as filename, e.g.
1 W0001). Some web pages may contain links to other relevant web pages or
documents so take your time to explore and record any other relevant data on the web
page. After you are finished, return to the list of search results. Enter all other necessary
information in the corresponding fields of the ‘Webpage’ component (see Appendix I).
After you are finished and ready to record new web pages, click ‘insert item’ under the
current ‘Webpage’ component. This will add a new, empty ‘Webpage’ component.

4. If you found a relevant document, save it to the ‘Documents’ folder of the case folder
(use the document number as filename, e.g. 1_D0001). Enter all other necessary
information in the corresponding fields of the ‘Document’ component (see Appendix I).
After you are finished and ready to record new documents, click ‘insert item’ under the
current ‘Document’ component. This will add a new, empty ‘Document’ component.

5. For each search you perform view and check 10 pages of search results unless it is very

clear that the search delivered few or no relevant search results.

For LexisNexis searches there is a separate procedure:

1. Go to http://academic.lexisnexis.nl/eur/ (it is advisable to save this web address as a
favourite in your browser);
2. Select the necessary search criteria (typically you will only need to change the first date

of the search to 1-1-1995; also see Appendix I). If you need to use the Advanced search



option or the Boolean search option (only use this if absolutely necessary), make sure
that you record all information necessary for others to reproduce your search;

3. After you performed a search, make sure that there are not too many search results (if
more than 200 search results are reported, it is advisable to perform a more specific
search). Having only a few search results is not necessarily a problem but make sure
that there are at least a few relevant ones among them;

4. If you have a reasonable amount of search results (see point 3), you are ready to export
them to PDF files. To do this, click the icon for saving search results (the icon that looks
like a floppy disk to the right of the screen). This will open a new screen. There are a few
things that you need to do here:

a. Change the document format to PDF,;

b. Select the number of the search results you want to export;

c. Save the file to the ‘LexisNexis’ folder of the case folder and use the LexisNexis
number as file name (e.g. 1_L0001). LexisNexis will only allow you to export 10
search results each time. Therefore, you will have to use a separate LexisNexis
component for each PDF file you save (each containing up to 10 search results).
For example, if you have 151 search results, the first component (e.g. 1_L0001)
will record search results 1 to 10 of 151 (you need to enter these numbers in the
News item No. fields; see Appendix 1), the second component (e.g. 1_L0001) will
record search results 11 to 20 of 151, and so on.

5. You will typically need multiple components to be able to record all results of one search.
To add a new component, click ‘insert item’ below the current component. Make sure

that you fill out all the necessary fields for each component (see Appendix I).



ITERATIVE SEARCHES

The data collection strategy is to some extent an iterative strategy. In later stages of the
research project (for example, after performing pilot studies or during the first analyses) it will be
necessary to search for additional information. In these cases we can usually already perform
more specific searches, without having to check all 10 pages of search results. For these
searches the ‘Webpage’ and ‘Document’ components have fields that can be used to indicate
whether a webpage or document was found through a specific search (and which search engine

and keywords were used for that).

Hint: It is useful to remember that every ‘Webpage’, ‘Document’ and ‘LexisNexis Search
Results’ component corresponds to its own file in (the subfolders of) case folder. If you are
unsure about how this works, check out other case folders and forms for examples of how the

system works.

A3.3 APPENDIX I

GENERAL INfORMATION COMPONENT

e Reporter: enter your name here;

e Industrial park: enter the name of the case here;

e Case number: enter the case number here (this number is taken from the original
SenterNovem database; it will be assigned to you).

e Date of first entry: select the date on which you first enter information into the form;

o Date of last change: select the date on which you made your last changes to the form
(always remember to update this field);

e Search engine: enter the search engines you used for your searches here and separate

them with a semicolon (;). The search engines will typically be google and lexisnexis;



Justification keywords: always motivate the keywords that were chosen by you in this
field. There are no specific instructions for this;
Reporter working notes: you can use this field to keep notes for yourself while you are

working on this case.

WEBPAGE COMPONENT (REPEATABLE)

Webpage no.: the first field will be automatically filled if you have entered the case
number field in the ‘General information component’. The second field needs to be filled
manually. Use a four digit number to number the web page (use ‘0001’ for the first web
page you record, ‘0002’ for the second, and so on). The two numbers and the * W’
symbol together constitute the Webpage number (e.g. 1_WO0001) which is used to name
webpages stored in the Webpages folder.

Webpage address: enter the address of the web page here;

Result of specific search: only check this box if you found this web page through a
specific search, using specific keywords (this is typically in a later state of the data
collection);

Search Engine: if you performed a specific search, enter the search engine that you
used in this field;

Keywords used: if you performed a specific search, enter the keywords you used in this
field;

Date exported to pdf: select the date that you exported the web page to PDF;

Hosting organization: enter the name of the organization that hosts this web page field;
Short description of contents: give a short description of the web page’s contents in this

field.



DOCUMENT COMPONENT (REPEATABLE)

o Document number: the first field will be automatically filled if you have entered the case
number field in the ‘General information component’. The second field needs to be filled
manually. Use a four digit number to number the document (use ‘0001’ for the first
document you record, ‘0002’ for the second, and so on). The two numbers and the * D’
symbol together constitute the Document number (e.g. 1_D0001) which is used as to
name documents stored in the Documents folder.

e Document name: enter the name of the document in this field;

e Year of publication: enter the year that the document was published here. If this year is
unknown, simply enter ‘unknown’;

o Published by: enter the name of the person/organization that published the document in
this field. If the name is unknown, simply enter ‘unknown’.

e Senter Novem project description: only check this box if the document is a SenterNovem
project description;

o Type of document: select the type of document here. If the document fits none of the
types, select ‘other’;

o If other: only use this field if you selected ‘Other’ in the ‘Type of document’ field.

e Web address: enter the web address where the document was found in this field
(sometimes the google chrome browser automatically downloads documents if you
select them from the search results, instead of brining you to the web address where the
document is located. In these cases right-click the document in the list of search results
and select ‘Linkadres kopiéren’ or ‘Copy link address’ and then pasted the copied

address in the field of your form);



Result of specific search: only check this box if you found this document through a
specific search, using specific keywords (this is typically in a later state of the data
collection);

Search Engine: if you performed a specific search, enter the search engine that you
used in this field;

Keywords used: if you performed a specific search, enter the keywords you used in this
field;

Short description of contents: give a short description of the document’s contents in this

field.

LEXISNEXIS SEARCH RESULTS COMPONENT (REPEATABLE)

LexisNexis number: the first field will be automatically filled if you have entered the case
number field in the ‘General information component’. The second field needs to be filled
manually. Use a four digit number to number the LexisNexis file (use ‘0001’ for the first
file you record, ‘0002’ for the second, and so on). The two numbers and the *_L’ symbol
together constitute the LexisNexis file number (e.g. 1_L0001) which is used as to name
LexisNexis files stored in the LexisNexis folder.

Keywords used: enter the keywords you used for the LexisNexis search in this field;
Dates used: select the search dates that you used for the LexisNexis search. These will
typically be 1-1-1995 as the start date end the date of the search as the end date;

News item No.: LexisNexis search results can be saved to PDF but only ten news items
can be saved in each file. These fields are used to indicate which news items are saved
in this specific LexisNexis file;

Selected sources: enter the sources you used for the LexisNexis search in this field. This
will typically be ‘Alle Nederlandstalige bronnen’;

Comments (optional): if necessary, add any comments on the LexisNexis file in this field.



INDUSTRIAL PARK COMPONENT (OPTIONAL)

Name of industrial park: this field is automatically filled if you filled out the ‘Industrial
Park’ field in the ‘General information’ component.

Size of industrial park (as reported in IBIS): enter the amount of hectares that is reported
for this park in the IBIS database in this field;

Type of industrial park: select the type of industrial park here;

Description of industrial park: this field can be used to give a description of the industrial

park.

PROJECT COMPONENT (OPTIONAl AND REPEATABLE)

Project name: enter the name of the project in this field;

Type of project: select the type of project here. If the project fits none of the types, select
other;

If other: only use this field if you selected ‘other’ in the ‘Type of project’ field;

Date of start: select the date that the project was started here;

Date of ending: select the date that the project was ended here;

Status of project: select the project status here;

Reason for Cancellation: only use this field if you selected ‘Cancelled’ for the ‘Status of
project field’;

Connected to policy programs: enter the policy programs that are connected to this
project here and use semicolons (;) for separation;

Received subsidy: check this box if the project received subsidy;

From policy programs: enter the policy programs from which the project received
subsidy here and use semicolons (;) for separation;

Project description: you can use this field to give a description of the project.



OTHER FIELDS

¢ Comments: use this field for any relevant comments on this case. Also, if you used any
additional data types (instead of web pages, documents or LexisNexis files), use this
field to indicate how you found this information, where you found it, and where and how

you stored it in the corresponding case folder.



ANNEX 4: THE METADATASET
A4.1 INTRODUCTION

The structure for the metadataset was developed to record data on all sources that are collected
in the process of data collection that was applied in this thesis. In this description, the basic

structure of the dataset is explained.

Main Form

Date of first entry: _Date of last change:
Case Name:_ Update one start: _Date of last change:
Case Number: - Update two start: _Date of last change:
Update three start: _Date of last change:
|

Reporter:

Justification keywords:

-
[
[ Open Webpages Form ] [Open Documents Form] [Dpen LexisNexis Form ]

Figure A4.1: Main form of the metadataset structure.



A4.2 DESCRIPTION OF THE DATASET STRUCTURE
Figure A4.1 shows the main form of the metadataset structure. In this form general details about

the data collection processes are filled in. This includes the following:

Name of the data collector;

¢ Name of the case;

e Number of the case;

e Dates that data was collected;

e The search engines used (e.g. Google, LexisNexis)
e The Keywords used;

o Justification of keywords;

Working notes (optional).

At the bottom of the main form there are several buttons with which subforms can be opened.
There is a separate subform for each type of source that was collected for this thesis:
Webpages, Documents, and LexisNexis files (collections of news items). A separate folder for
each type of source is created on the hard drive of the user, and pdf-files of the sources are
stored in these folders. The names used for the source files correspond with the system used in

the metadataset. The following structure is used

e [case number]_W][source_number] for webpages (e.g. 1_W0001);
e [case number]_D[source_number] for documents (e.g. 2_D0004);

e [case number]_L[source_number] for LexisNexis files (e.g. 3_L0005).

Figure A4.2 shows the form for webpages. Each webpage is assigned a number that is also

used as the name of the corresponding source file. The case number is automatically filled in



based on the case number that is indicated on the main form. The source number must be filled

in manually. The webpages form also records the following other information:

The URL of the webpage;

e The date that the webpage was downloaded as a pdf;

e The host of the website;

o Whether the source was found based on a specific search (see below);
o If yes, the keywords that were used in the specific search;

o If yes, the search engine that was used;

e A brief description of the source (optional).

Webpages Form
IDCode: .50 W
URL:
Retrieval date:
Host:
Specific search:
Keywords used:
Search Engine:
Description
i H q N . Go to source: - &

Figure A4.2: Webpages subform



Some of the webpages and documents were not found through the standard search

operations, but through specific, smaller searches. What distinguishes these searchers from

the standard approach is that data collection was stopped when a specific source was

found. These searches were performed to fill certain ‘gaps’ in the data. For example, in

some cases specific searchers were performed to get a more specific indication of the date

at which a certain event happened.

Figure A4.3 shows the subform for documents.

DocumentsForm

Documents Form

oceo- EEN o N

Year Published: -

Specific Search: [ Novem Document: |Bl

Search Engine:

Keywords used:

=i H 4 b M e Go to source: -H

Figure A4.3: Documents subform.

For documents the following information is recorded:



e The title of the document;

e The year the document was published,;

e The publisher of the document;

e The URL from which the document was retrieved;

¢ Where the source was found based on a specific source;
o If yes, the search engine that was used;
o If yes, the keywords that were used;

e A brief description of the document (optional).

Figure A4.4 shows the subform for LexisNexis files.

3 LexisNeisForm *

LexisNexis Form

Figure A4.4: LexisNexis files subform.

The LexisNexis files were typically documents with 10 news items each. The following

information is recorded:



The keywords used in the LexisNexis dataset;

The dates used for the search in the LexisNexis dataset;

The numbers of the items in the current LexisNexis file (e.g. in case the search gives
201 results, and 10 new items are stored in each file, then the second file would hold
item 11 to 20 of 201).

The sources selected for the search (all Dutch news items were used here in all
searchers);

Comments (optional).



ANNEX 5: THE EVENT SEQUENCE DATASET
A5.1 INTRODUCTION

The Event Sequence Dataset (ESD) structure is the structure that was used to enter, store, and
code the event data. Some of the basic characteristics of the dataset structure are described

here.

A5.2 DESCRIPTION OF DIFFERENT FORMS
The main form of the ESD structure is the ‘main menu,” where the user can get access to the
form used to write and code incidents, the form used to develop the code book, as well as a

number of options to preview and export data (see figure A5.1).

= WelcomeForm x

Enter case name

MENU

l Open Incident Entry Form l [Exp-on‘ uncoded Incidents

l Open Codebock l | Export Coded Incidents I
l Prewview Incidents l [ Export CodeBock l

l Delete All Codes l

Warning: this action
cannot be undone

Notes:

Figure A5.1: Main menu of the ESD.



When the user selects the option “Open codebook”, the form visualized in figure A5.2 is
opened. This form has two different views. In the default view the user can record up to 60 code
labels. These labels can be used for categorical coding and show up in the form that is used to

record and code incidents (see below). In the example in figure A5.2 two labels have bee

assigned.
COdebOOK | Open Coding Tracks J | Close Form |
Code it | Exomple Code Code 21: Code 41:
Coe 23 Exomple Code 2 Code 22: Code 42:
Code 3: Code 23: Code 43:
Code 4: Code 24: Code 44:
Code 5: Code 25: Code 45:
Code &: Code 2é: Code 44:
Code 7: Code 27: Code 47:
Code 8: Code 28: Code 48:
Code 9: Code 2%: Code 4%:
Code 10: Code 30: Code 50:
Code 11: Code 31: Code 51:
Code 12: Code 32: Code 52:
Code 13: Code 33: Code 53:
Code l4: Code 34: Code 54:
Code 15: Code 35: Code 55:
Code 16: Code 34: Code 5&:
Code 17: Code 37: Code 57:
Code 18: Code 38: Code 58:
Code 19: Code 39: Code 59:
Code 20: Code 40: Code &0:

Figure A5.2: Code book form (view 1).

A second view can be accessed by clicking the “Open Coding Tracks” button. The second view
is visualized in figure A5.3. The open coding tracks can be used to write codes (typically
descriptive codes) ‘on the fly’. This is most useful if coding categories have not been identified in
advance. It is possible to used 10 separate coding tracks, in case the user has certain coding
categories in mind but wants to develop more specific codes within these categories ‘on the fly.’

In the example in Figure A5.3 two coding track labels have been assigned.



Codebook (CloseForm |

Open Coding Track | Ccding frack example
Open Coding Track Coding trock example 2
Open Coding Track

Open Coding Track

Open Coding Track

Open Coding Track

Open Coding Track

Open Coding Track

Open Coding Track

Open Coding Track

Figure A5.3: Code book form (view 2).

If the user selects the option “Open Incident Entry Form” from the main menu, the form
visualized in figure A5.4 is opened. This is the form that the user uses most often. Here the
qualitative data on events are entered as incident descriptions (see chapter 3). The following

fields can be used to record incident data:

e Date;

e Accuracy of date (to day, to month, or to year);

e Subsequence (optional);

e Incident, i.e. a description of (inter)action and the actor(s) performing it;
e Background (optional field for additional information);

e Source of the data.



=2 Incident Entry Form x

Incident Entry Form

= ==z [=]
incident
 sowee: |
Codes [ ievetimeaa |
[ [SampleCode | I R O O e e
* Eanpacoiz I I R R
O © N N N T ) ——
O I N C I . ——
O - I - - © N -
@l  jal  fal e Al
C T~ - R
O O (I O (N
D O O ) O C——
Ol " " T O ©
e e 0
S = @eE
. WARNING: Always
[l( l 4 l Incident 1 of o0 [. HN lselecl Record with Specific Date: E' delete codes csrom[@
L deleting an incident!

Figure A5.4: Incident Entry Form (view 1).

The form also includes a separate section that can be used for coding purposes. This section
has two different possible views (also see figure A5.5). The first view is for categorical coding.
The code labels correspond to those recorded in the code book form. Codes can be assigned
by ticking the corresponding tick box. The code will be assigned to the incident that is currently
being viewed by the user. A memo can also be included. The view for open coding can be

accessed by clicking the “Active Open Coding” button.



E Incident Entry Form b4

Incident Entry Form
oo~ g

Codes Adlivale Open Codng
Coding track example | Actors Involved:
Coding track
[ |
= [ Futincidentsin
#
& -’ I _cmnologicalcauur l L] H — l

—_— WARNING: Ahways
4 4 | Incident 1 of o E p| | Select Record with Specific Date: |Z| delete codes before ﬁ
delefing an incident!

Figure A5.5: Incident Entry Form (view 2).

The incidents that are recorded in the dataset can be put in chronological order by clicking the
corresponding button in the Incident Entry Form. The incidents will also be automatically
ordered if the user closes the form. After recording (and possibly coding) the incidents, the
dataset can be exported in both coded and uncoded form from the main menu. The dataset will

be exported as an excel-file (see Annex 6).



ANNEX 6: RETREIVING DATA FROM DATASET
A6.1 INTRODUCTION

In this thesis, event data are recorded in Event Sequende Datasets (ESDs). After recording
(and possibly coding) the data, the dataset is exported as an excel-file, after which additional
preparations of the data can be performed. The result of these preparations is a dataset in

which incidents are:

e Assigned a unique identification number;

e Listed in chronolical order,

e Labelled with codes;

e Grouped into events (each event is assigned a number and distinguished with thick, red

borders);

Figure A6.1 shows a screenshot of an example dataset. In this case the intentional linkages
between incidents (see chapter 3) are recorded in a separate column (G). The numbers
recorded in this column refer to the identification numbers of earlier incidents that are recorded
in column A. If there are multiple earlier incidents that are intentionally linked to any other
incident, then they are all recorded in column G and separated with semicolons.For example, if
for incident with identification number 16 (column A) column G reports the numbers 2;4, this
means that both incident 2 and 4 are intentionally linked to incident 16. The intentional linkages
between incidents were also translated to intentional linkages between events. Using the earlier
example, if both incident 2 and 4 are grouped in event 2, and incident 16 is grouped in event 8,
then the ealier identified intentional linkages between the incidents are translated to a single

intentional linkage between events 2 and 8.
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Figure A6.1: Example of Excel file with event data.



The information on linkages between events is used for the creation of event graphs (see
Annex 7). Before that is possible, the data on the linkages needs to be retrieved from the
dataset. To do this, the necessary data first have to be stored in a csv-file. For this procedure
you will need Gephi, including the third party pluging for retrieving data from csv-files'. To do

that the following steps have to be taken:

1. Select the columns with the event identification numbers and the linkages (see figure

A6.2) and copy these to an empty sheet of the excel file.

Figure A6.2: The columns with event identification numbers and linkages are selected.

2. Currently, the columns have many empty cells. To remove these (this is optional,

because they will be automatically removed later), first select both columns and press

1t Gephi is an open source program for network visualization. It is also very useful for converting data
to various formats. It is available at https://gephi.github.io/. To retrieve the data, a third-party plugin
was used (Levallois 2013).



https://gephi.github.io/

the F5 function key. This opens the screen shown in figure A6.3 (on the left). Then
click the “Special” button, which opens another screen (see figure A6.3 - right). Then
select “Blanks” and click “OK”. The empty cells in either of the two columns will now
be selected. Now go to the “Home” tab in excel and select “Delete Sheet Rows” from
the “Delete” drop-down menu. N ow all rows with empty cells are removed (see figure

AB.5).

™ Go To Special

| coto: | Comments i Row differences
IncWithCodesQry ﬂ Constants Column differences
| {7 Formulas " Precedents
[¥ Numbers " Dependents
V¥ Text t¥ Direct only
| ¥ Logicals Al levels
¥ Errors i Last cell
| & Visible cells only
lI i~ Current region i~ Conditional formats
" Current array " Data validation
Reference:
| || | {7 Objects Al

" Same

Special... | OK I Cancel | | oK I Cancel

Figure A6.4: Screens used to select empty rows in an excel-sheet.

3. Save the current excel sheet as a csv-file. This can be done by going to the “File”
menu, and selecting “Save As.” Make sure you select “CSV (Comma delimited)

(*.csv)” from the “Save as type” menu. Save the file in a location that is easy to find.
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Figure A6.5: The columns with event identification numbers and linkages without empty

cells.

4. Open the Gephi program and make sure that you have the necessary third-party
plugin for retrieving data from csv-files installed (Levallois 2013). If the plugin still
needs to be installed, this can be done from within the program. Go to “Tools”, and
then select “Plugins.” The plugin can be found from the list of “Available Plugins”
(search for “csv” and it should turn up). The plugin is named “Convert Excel and csv
files to networks”. If the plugin is already installed, go to “File” and select import

spigot. This opens the screen shown in figure A6.6.



Steps Select Spigot (1. from 2)

1. Select Spigot .
7 Category: Spigot Type:
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Description:
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< Back {Next::» Eimish | [Cancel|| Help

Figure A6.6: Import Spigot screen.

5. In the Import Spigot screen, select the option “Data importer (co-occurrences)” and
click next. In the next screen, select the appropriate file (also select the option that
your file has headers). After selecting the file you are asked to select an appropriate
delimiter. The delimiter that is used in your file will depend on your system settings. If
you are unsure what to select here, experiment with a few options. If you selected the
appropriate delimiter, the two columns in your file will be shown in the next screen as
two separate column names (see figure A6.7).

6. Inthe next screen (figure A6.7) select your column with linkages from the top field
and select your column with event identification numbers from the bottom field and go

to the next screen.



Steps Select agents (3. from 7)

1. Select Spigot
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File
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< Back | Next > Cancel

Figure A6.7: Screen where columns to be linked are selected. In this example the column

“Event” records the event identification numbers and the column “Past” records the linkages.

7. Inthe next screen you should indicate that the field with linkages is made of subfields
that are distinguished by semicolons (see figure A6.8). After doing this, you can
simply continue clicking “Next” until you click the “Finish” button (no other options
have to be used anymore).

8. In the dialog that opens, make sure that the “Graph Type” is set to “Directed” (it is set
to “Undirected” by default. The graph is directed because intentional linkages are
directed as well. After selecting this option, you can click the “OK” button and the data

will be imported.



Steps Subfields in agents (4. from 7)

=y
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== Please choose "semicolon” as a delimiter, -

<Back | Next>l Cancel

Figure A6.8: Screen where you select semicolon as separator for linkages.

9. Now that the data are imported into Gephi, it is possible to export the data in different
formats. One possibility is to export the data as a matrix by using “File” and the
selecting “Export” and “Graph File.” By default, the graph is exported as a csv-file,
which will hold an adjacency matrix with your data. You can also export the nodes
(events) and edges (linkages) separately from the Data Laboratory (see Annex 7).

See http://gephi.github.io/users/ for further instructions on how to use Gephi.

The procedure above is describe specifically for retrieving intentional linkages from the ESD,
but the same procedure is used to retrieve other types of data from the dataset. For example,
if one wants to retrieve the data that indicates the relationships from actors to events, then
the same procedure is used. However, where the column with linkages was used in the
example above, one uses a column that records the actors that are involved in a given event.

The information on actor involvement should be recorded in more or less the same way as


http://gephi.github.io/users/

the information on linkages between events. For example, if the actors “Actor_A” and
“Actor_B” are both involved in event 6, then there should be a column in the dataset that

records “Actor_A;Actor_B” in the cell that corresponds to the row of event 6 (see figure A6.9).
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Figure A6.9: Example of columns that record the involvement of actors in events.



ANNEX 7: CREATION OF EVENT GRAPHS
A7.1INTRODUCTION

Annex 6 describes a procedure that can be used to retrieve information on the intentional
linkages between events from the Event Sequence Dataset (ESD). Here, a description will
be offered of the way in which event graphs can be created, using the data that was retrieved
using the procedure of Annex 4. The description assumes that the data on linkages between
events has been correctly imported into Gephi. It also assumes that you have installed the
Event Graph Layout for Gephi. This can be done from within Gephi by going to “Tools” and

then “Plugins”. Search for the Event Graph Layout in the list of “Available Plugins”.

A7.2 EXPORTING THE NODES AND EDGES

Go to the data laboratory in Gephi (see http://gephi.github.io/users/ for basic instructions on

how to use Gephi). From the data laboratory, export both the nodes list and the edges list as
csv files. For the nodes only the Id and the Label will be used, so the other fields can be
deselected in the export dialog. Once both lists are exported, open the nodes list in Microsoft
Excel. Typically, the order of the events in the file is more or less random. Make sure that the
data are correctly sorted first (use the “Sort” option from the “Data” tab in Excel). This option

requires the events to be recorded as numbers (see figure A7.1)%

To be able to make an event graph a variable must be added to the nodes that indicates their
order of occurrence. This can be achieved simply by adding a new column with numbers that

count up from 1 (see figure A7.1). This field can be simply called “Order”.

2 At this step it is also possible to add the numbers of events that are not linked to other events. This
can be achieved by simply adding them to the list. In the event graph these will show up as isolates.
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Figure A7.1: Sorted nodes list before adding order column (left) and after adding order

column (right).

Save the new version of the file and go back to Gephi. In Gephi you start a new project and
go to the data laboratory. Here, you first import the new version of the nodes list. Make sure
that in the import dialog you import the newly added “Order” variable as a “Double”. Then
import the edges list that you exported earlier. No changes have to be made to the options

here. After doing so, go back the overview in Gephi.

From the Layout menu, select the Event Graph Layout (see figure A7.2). Typically, the Order
variable will be automatically selected for the Order option. If not, do so manually. Different
settings can be set here, and it takes some experimentation to find out which settings work
best for your graph. If you want the layout to automatically set the vertical layout of the

events (using a force-based algorithm), make sure that the box for “Set Vertical Force” is



ticked. The layout can now be run. For more detailed instructions on the different settings to

use, please see https://marketplace.gephi.org/plugin/event-graph-layout/.

Layout =
Event Graph Layout =
o B Run
~Time Force Layout

Scale of Order 10.0

Order Order -
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Vertical Scale 1.0

Strong Gravity Mode [

Gravity 1.0

Jitker Tolerance 0.3

Threads 2

Center ]

Figure A7.2: Event Graph Layout menu.



